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Chapter 13

Adjustments and Year-
End Procedures

Objectives

After completing this chapter, you should be able to:
s Edit, void, and delete transactions (page 419)
s Make General Journal Entries (page 423)
» Memorize and schedule transactions to be automatically entered (page 426)

¢ Close the year and enter special transactions for sole proprietorships and partnerships
(page 430)

e Set the closing date to lock the company file (page 435)

Restore this File:

This chapter uses Adjustments-12.QBW. To open this file, restore the
Adjustments-12.QBM file to your hard disk. See page 8 for instructions on
restoring files. If you are using QuickBooks Premier Accountant, we recommend
that you toggle to QuickBooks Premier General Business as described on page x.

periods, and you'll learn how to use journal entries and zero-dollar checks to adjust
balances and close the year. You will also learn how to memorize transactions and use the
closing date in QuickBooks.

I n this chapter, you will learn how to edit and void transactions in current and closed

Editing, Voiding, and Deleting Transactions

Unlike many other accounting programs, QuickBooks allows you to change any transaction at
any time as long as you have sufficient privileges. However, you should almost never change
transactions dated in closed accounting periods, or transactions that have been reconciled
with a bank statement.

Key Term:
For the purposes of this discussion, a Closed Accounting Period is a period for
which you've already issued financial statements and/or filed tax returns,

When you change or delete a transaction, QuickBooks updates the General Ledger with your
change, as of the date of the modified or deleted transaction. Therefore, if you modify or
delete transactions in a closed accounting period, your QuickBooks financial statements will
change for that period, causing discrepancies between your QuickBooks reports and your tax
return.
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420 Adjustments and Year-End Procedures — Editing, Voiding, and Deleting Transactions

In QuickBooks, the Closing Date field is used to “lock” your data file to prevent users from
making changes on or before a specified date. See page 435 for information about setting the
Closing Date in QuickBooks.

Tip:

Using the Closing Date, a period can be “closed” even if there is no tax return for
the period. For example, you can close the books through January 31, 2015,
even though your last tax return was dated December 31, 2014. If management
makes decisions based on printed financial information dated January 31, 2015,
any changes to QuickBooks information dated before January 31, 2015 will
cause the reports in QuickBooks to disagree with the printed reports. Also, many
companies submit financial information to third parties (e.g., banks) during
their tax year on a monthly or quarterly basis.

Some companies close their books monthly, but other companies only close the books
quarterly or annually. Make sure you know how often your company closes periods before
you make changes to transactions that might affect closed periods.

Tip:

At the very least, you shouid lock the file at the end of each fiscal and/or
calendar year. You may also choose to lock the file monthly, after you perform
bank reconciliations and adjusting entries for the month.

Editing Transactions

From time to time, you may need to modify transactions to correct posting errors. To edit (or
modify) a transaction in QuickBooks, change the data directly on the form. For example, if
you forgot to add a charge for an Outdoor Photo Shoot to Invoice 2015-106 and you have not
already sent the invoice to your customer or client, you will need to add a line for the photo
session on the previously created invoice,

COMPUTER PRACTICE
To edit an existing transaction, follow these steps:

Step 1. From the Customers menu, select Create Invoices. If QuickBooks displays a
Professional Services Forms dialog box, click OK.
Step 2. Click Previous to display Invoice 2015-106 dated 2/28/15 (see Figure 13-1).
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Step 3. Click on the second line in the main body of the invoice and enter Outdoor Photo
Session in the /tem column. Press Tab.
Step 4. Enter 3 in the Quantity column and then press Tab (see Figure 13-2).
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Step 5. Click Save & Close to save the Invoice,
Step 6. On the Recording Transaction window, click Yes. This message confirms that you
really want to change the transaction (see Figure 13-3)
Recording TraﬂSB;thl"l B fs e 3

You have changed the transaction. Do you want to record your changes?

] [ | [ Lcon ]

Figure 13-3 Recording Transaction window

Note:

Do not use this method of changing transactions if you have already sent the
Invoice to the customer, In that case, you would need to create a new Invoice with
the separate charge. Also, you should never change transactions dated in a
closed accounting period.

Voiding and Deleting Transactions

Voiding and deleting transactions both have the same effect on the General Ledger - the effect
is to zero out the debits and the credits specified by the transaction.

There is one significant difference between voiding and deleting. When you void a
transaction, QuickBooks keeps a record of the date, number, and detail of the transaction.
When you delete a transaction, QuickBooks removes it completely from your file.

The Audit Trail feature of QuickBooks tracks changes and deletions of transactions. The Audit
Trail Report lists each accounting transaction and every addition, deletion, or modification
that affects that transaction. For more information about the Audit Trail, see the QuickBooks
Onscreen Help.

In addition to the Audit Trail, QuickBooks has a Voided/Deleted Transactions Report that lists all
voided and deleted transactions. This report is very useful when you have a number of users
in a file and transactions seem to “disappear,” since the report shows the time, date, and user
name of the changes or deletions.

In general, voiding is better than deleting transactions. In either case, make sure you keep a
record of voided and deleted transactions. The record should include the date of the voided or
deleted transaction and the reason for it.

To delete a transaction:

1. Select the transaction you wish to delete; it may be displayed in a register or form.
2. Select the Edit menu and then select Delete (or press Ctrl+D).

3. On the Delete Transaction window, click OK,

To void a transaction:

1. Select the transaction in a register or display it in the form.

2. Select the Edit menu and then select Void (or right-click on the transaction and seiect
Void from the shortcut menu),

Click the Record button at the bottom of the window.

4. If you attempt to close the window without recording the transaction, the Recording
Transaction window displays. If this is the case, click Yes to record the transaction.
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Note:

Proper accounting procedures do not allow you to simply delete transactions at
will. However, in some cases it is perfectly fine to use the Delete command. For
example, it is acceptable to delete a check that you have not printed. On the
other hand, if you have already printed the check, you should Void the check
instead of deleting it. That way, you will have a record of the voided check and
keep the numbering sequence intact in the register.

Deleting All Transactions

Occasionally, you may wish to delete all transactions from a file, while leaving the Customers,
Vendors, Employees and other List information as well as the Preferences in the file. QuickBooks ‘
Condense Data Utility allows you to make these changes. You have the option to either delete
all transactions, or delete all transactions except for transactions within a specific date range.

You can access the Condense Data command from the Utilities submenu under the File menu.
QuickBooks prompts you to select a specific date to delete transactions before, or to delete all
transactions. Do not do this now with your exercise file.

8 What transactions do you want to ramove?  belome choose

& Transactions befora a spedific date
Remave transactions before @51}2—5@:@“’}

@ Ab transactions
 QuickBooks wil keep lists and preferences

[ e | Cobiman) | sconcouense | " wp, | [ cand

Figure 13-4 Condense Data Utility

General Journal Entries

General Journal Entries are transactions that adjust the batance of two or more accounts.

Note:

Good accounting practice suggests that you keep a separate record of each
General Journal Entry you make in QuickBooks. This record will be very helpful if
you are ever audited or if you have to research the reasons for the adjustment.

Here are a few examples of adjusting entries in QuickBooks:

¢ Recategorize a transaction from one Class to another.

Recategorize a transaction from one account to another.

Allocate prepaid expenses to each month throughout the year.

Record non-cash expenses, such as depreciation.

Close the Owner’s Draw account into the Owner’s EQuity account.
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In most cases, you will use a Gewneral Journal Entry to record adjustments.

Creating a General Journal Entry

Note:
Depending on your QuickBooks user settings, you may need permission from
the QuickBooks administrator to create General Journal Entries.

COMPUTER PRACTICE
Step 1. Select the Company menu and then select Make General Journal Entries.

Those using QuickBooks Premier Accountant should select the Accountant menu and
select Make General Journal Entries.

Step 2. If the Assigning Numbers to Journal Entries window opens, check the Do not display
this message in the future box and click OK.
Step 3. Enter 07/31/15 in the Date field and then press Tab (see Figure 13-5).

If you are using QuickBooks Prernier Accountant, your window may look different
than Figure 13-5.

Step 4, Make sure 2015-1 is already in the Entry No. field. Press Tab.

The very first time you enter a General fournal Entry, enter whatever number you
want in the Entry No. field. Then, when you create your next General Journal Entry,
QuickBooks will increment the entry number.

Step 5. On the top line of the Make General Journal Entries window, enter fournal Entries in
the Account column. Press Tab three times to leave the Debit and Credit columns
blank for this line.

Expert Tip:

In these examples, we use a bank account called Journal Entries on the top line of
each Journal Entry. If you create the Journal Eniries bank account and then enter it
on the top line of each General Journal Entry, QuickBooks tracks all the General
Journal Entries in a separate register on the Chart of Accounts. This register allows
you to quickly look up and view all of your General Journal Entries. Though you
use this account in every General Journal Enfry, you will never debit or credit the
account and therefore it will never have a balance.

Step 6. Enter Recategorize Expense in the Memo column. Press Tab three times to leave the
Name and Class columns blank for this line.

Step 7. Enter the information on the next two lines as shown in Figure 13-5.
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i 67100 - Rent Expense 25,62 |Recategorize Expense

Account Debit Credit Memo Name plable?  Class P

i} { 10900 - Joumal Entries Recategorize Expense s
H {68500 - Utibes 25.62 Recategorize Expense (1
;

If you enter a Memo on the
s first line, QuickBooks will
b post the Memo to each
line of the Journal Entry.

Ll 1 - |

Totals 25.62 25.62 | :5
[saveacose | [ savembew |[ Gexr |-

e

b o i ST

Figtfré 73-5 General Journal Entry window

Note:
General Journal Entries must balance. The total of the Debit column must match

the total of the Credit column.

Step 8. Click Save & Close to save the transaction,

Adjusting Expense Accounts Associated with Items (Zero-Dollar Checks)

If you use Itfems to track the details of your expenses, you may need to enter adjustments to
the [tems as well as the accounts te which the Ifemns are assigned.

However, the Journal Entry window in QuickBooks has no provision for entering Items as part
of the journal Entry.

To solve the problem, use a transaction (such as a Check) that allows you to use Items. The
Check will be a “Zero-Dollar Check” in that it will have an equal amount of debits and credits |
in the splits area of the transaction. You can use the Journal Entries bank account so you don’t
clutter the normal bank account with zero-dollar checks. i

DO NOT PERFORM THESE STEPS NOW. THEY ARE FOR REFERENCE ONLY.

Follow these steps to use zero-dollar Checks as Journal Entries:
1. Create a Check using the Journal Entries bank account.

2. Enter the debits as Items with positive amounts and the credits as Iterns with negative
amounts as shown in Figure 13-6 below. The total Check amount should net to zero.
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Figure 13-6 Using the Write Checks window to create a fournal Entry affectmg ;ob cost

3. To review the adjustment to the General Ledger, save the zero-dollar Check, select the
Reports menu and then select Transaction Journal. QuickBooks displays the report
shown in Figure 13-7 below.
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Figure 13-7 Transaction Journal from the Zero Dollar Check

In addition to the example above, zero-dollar Checks are very useful for adjustments involving
any combination of Ifems and expenses. Similarly, you can use zero-dollar Sales Receipts to
adjust items that affect income accounts.

Memorized Transactions

If you frequently enter the same transaction (or similar ones), you can memorize and schedule
the entry of the transaction. For example, if you want QuickBooks to automatically enter the
depreciation journal entry each month, you can memorize the transaction and then schedule
it to be automatically entered.

Note:

You can memorize Journal Entries, Invoices, Sales Receipts, Bills and other
transactions, however, there are some transactions that cannot be memorized,
such as Bill Payment and Receive Payment.
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Memorizing a Journal Entry

COMPUTER PRACTICE
To memorize a transaction, follow these steps:
Step 1. Create a General Journal Entry with the data from Figure 13-8

i.ﬂprarimli_ B Nea [3.5wve GiPrint.. | % History. @ Reverse ||

IO e —

 Account . . . Debit . Credt Memo e .
4 | 10900 - Journal Entries Monthly depredation sntry for Truck
#] 62400 - Depredation Expense Monthly depredation entry for Truck
31 | 17000 - Acoumuated Depredation Monthly depredation entry for Truck

Figure 13-8 Monthly Depreciation for Truck

Step 2. Before saving the General Journal Entry, select Memorize General Journal from the
Edit menu (or press Ctrl+M).

Step 3. Enter Vehicle Depreciation in the Name field.

Use names that you will recognize so that you can easily find this transaction in the
Memorized Transaction list.

Step 4. Set the fieilds as shown in Figure 13-9 to indicate when and how often you want the
transaction entered and then click OK.

| Name |Vehide Depredation

@) Add to my Reminders Ligt How Often | Monthly ‘.g

' © Do NotRemind Me NextDate [02/28/2015 [i8]

. @ Automate Transaction Entry Number Remaining s ]

- Add o Groug Dova In Advance Tomter [5 ]
GroupName eone> - -]

Figure 13-9 Vehicle Depreciation memorized information

Step 5. Select Save & Close to record the fournal Entry. If QuickBooks displays a dialog box
regarding Tracking Fixed Assets on jJournal Entries, click OK.

Step 6. If necessary, close all your open windows by clicking the close box (ﬁiﬁ) in the upper
right corner.

Did You Know?

You can memorize most transactions in QuickBooks. Just display the transaction,
then select Memorize [Transaction Name] from the Edit menu, or right click on

the transaction and select Memorize [Transaction Name]. You can also press ‘
Ctrl+M. The Memorized Transaction List contains all the transactions that you
have memorized. To display this list, select Memorized Transaction List from

the List menu.

Adjustments and Year-End Procedures — Memorized Transactions




428 Adiustments and Year-End Procedures — Memorized Transactions

Now, every time you launch QuickBooks, it checks your Memorized Transaction list for
transactions that need to be entered automatically. If the system date is on or after the date in
the Next Date field (minus the number in the Days In Advance To Enter field), QuickBooks will
ask you if you want to enter the memorized transaction.

Deleting, Rescheduling, and Editing Memorized Transactions

Rescheduling or Renaming Memorized Transactions

COMPUTER PRACTICE

To edit the schedule or name of a memorized transaction, follow these steps:

Step 1. Select the Memorized Transaction List from the Lists menu, or press Ctri+T,

SN v
- [ Memorized Transaction List

Transaction Name

Auts  NextDate -

" I

Edit Memorized Transaction m Ctrl+E
New Group
Delete Memorized Transaction Ctrl+ D

Customize Columns...

Print List... Ctrl+P
Re-sort List

Memorized Transaction ™| Enter Transaction

Figure 13-10 Memorized Transaction List

Step 2. Select the Vehicle Depreciation transaction in the Memorized Transaction List. Select
Edit Memorized Transaction from the Memorized Transaction drop-down list or
press Ctrl+E (see Figure 13-10).

Step 3. The Schedule Memorized Transaction window displays (see Figure 13-11). This
window allows you to reschedule or rename the transaction, but it does not allow
you to edit the actual transaction. Click Cancel and close all open windows.

TR "%«?‘fi"?"’.*‘ei‘?ﬂ

@ Schedule Memoriz df Transact

Name ;Vehide Depreclatlun _'

" Add to my Reminders List HowOften lmorty ] Gancel

" Do Not Remind Me NextDate |02/28/2015 (@]
i@ Automate Transaction Entry Number Remaining [119 “' ']
Add to Group Days In Advance To Enter Ea__m____:j
Gouphame | <Nore> ]

Figure 13-11 Schedule Memorized Transaction window
Editing Memorized Transactions

In addition to editing the schedule or other attributes of a memorized transaction, sometimes
it is necessary to edit the actual contents of the transaction such as the Items, prices, or
coding.

Adjustments and Year-End Procedures - Memorized Transactions




Adjustments and Year-End Procedures — Memorized Transactions 429

COMPUTER PRACTICE
To edit the contents of a memorized transaction, follow these steps:
Step 1. Select the Memorized Transaction List from the Lists menu, or press Ctrl+T.

Step 2. To edit the Vehicle Depreciation memorized transaction, double-click it in the ;
Memorized Transaction List.

This displays a new transaction (see Figure 13-12) with the contents of the
memorized transaction. You can change anything on the transaction and then
rememorize it. In this case, we will add the San Jose Class.

€ prin Bt 5o i | By oy Bhcene || § Auncn

Dste [02/26/2015[M] EntryNe. (20153

Monthly depredation entry for Truck
{Monthly depredation entry for Truck
Maonthly depredation entry for Truck

Figure 13-12 Edit the transaction as necessary

Step 3. To rememorize the transaction, select Memorize General Journal from the Edit
menu (in the program’s menu bar), or press Ctrl+M.

Step 4. To save your edited transaction in the Memorized Transaction list click Replace (see
Figure 13-13).

or add a new one?

: 0 Vehide Depredation is already in the Memorized Transaction ist. Would you like to replace it

Clelpe] (Lo ] [ conce ]

Figure 13-13 Replace Memorized Transaction message

Step 5. Click Clear to erase the contents of the fournal Entry and then click Save & Close.
This will save the changes to the memorized transaction without entering the
transaction in the General journal,

Deleting Memorized Transactions

COMPUTER PRACTICE
To delete a memorized transaction, follow these steps:
Step 1. Select the Memorized Transaction List from the Lists menu, or press Ctrl+T.

Step 2. The Vehicle Depreciation is already selected because it is the first and only ;
memorized transaction on the list. i

Step 3. Select Delete Memorized Transaction from the Memorized Transaction drop-down
list, or press Ctrl+D (see Figure 13-14),
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@ Mermoriaed Trapeaciontint -~

Transaction Name

Edit Memorized Transaction Ctri+E
New Group
Delete Memorized Transaction b Ctri+D

Customize Columns...

Print List... Ctri+P
Re-sort List

Enter Transaction |

Figure 13-14 Deleting Memorized Transaction 'opt'fon

Step 4. For now, click Cancel on the Delete Memorized Transaction dialog box so the
memorized transaction will not be deleted (see Figure 13-15).

@ Are you sure you want to delete this memorized transaction?

ok 1 | cancel |

Figure 13-15 Delete Memorized Transaction

Step 3. Close all open windows.

Closing the Year

At the end of each year, accounting principles dictate that you must enter an adjusting entry
to transfer net income or loss into the Retained Earnings (or Owner’s Equity) account. This
entry is known as the closing entry.

However, in QuickBooks you do not need to make this entry. QuickBooks does it for you,
automatically. When you create a Balance Sheet, QuickBooks calculates the balance in Retained
Earnings by adding together the total net income for all prior years. At the end of your
company’s fiscal year, QuickBooks automatically transfers the net income into Retained
Earnings.

On the left side of the example in Table 1, notice that the Balance Sheet for 12/31/2014 shows
net income for the year is $100,000.00. The right side shows the same Balance Sheet, but for
the next day (January 1, 2015). Since January is in a new year, last year's net income has been
automatically transferred to the Retained Earnings account.

Equity on Dec 31, 2014 Equity on Jan 1, 2015
Opening Bal Equity 0.00 Opening Bal Equity 0.00
Preferred Stock 50,000.00 Preferred Stock 50,000.00
Common Stock 75,000.00 Comrmon Stock 75,000.00
Retained Earnings 100,000.00 Retained Earnin 200,000.00
Net Income 100,000.00T | Net Income 0.00
Total Equity 325,000.00 Total Equity 325,000.00

Table 1 Example of QuickBooks closing entry
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There are two advantages to QuickBooks automatically closing the year for you. First, you do
not have to create the year-end entry, which can be time-consuming. Second, the details of
your income and expenses are not erased each year, as some programs require.

Closing the Accounting Period

The following is a list of actions you should take at the end of each accounting period.
Perform these steps as often as you close your company’s books. Many companies close
monthly or quarterly, while some close yearly. No matter when you close, these steps are to
help you create proper reports that incorporate year-end transactions. These entries may be
non-cash entries such as depreciation, prepaid expense allocations, and adjustments to equity
to properly reflect the closing of the year.

At the end of the year (or period), consider doing some or all of the following:

1 Enter depreciation entries.

2, Reconcile cash, credit card, and loan accounts with the period-end statements.

3 If your business has inventory, perform a physical inventory on the last day of the
year. Following the inventory count, enter an Inventory Adjustment transaction in
QuickBooks if necessary. See the “Inventory” chapter for more information about
adjusting inventory.

4. If you are on the accrual basis of accounting, prepare General Journal Entries to accrue
expenses and revenues. Ask your accountant for help with these entries.

5. If your business is a partnership, enter a General Journal Entry to distribute net income
for the year to each of the partner’s capital accounts. If your business is a sole
proprietorship, enter a General Journal Entry closing Owner’s Draw into Owner’s
Equity. See the section below for more information.

6.  Run reports for the year and verify their accuracy. Enter adjusting entries as necessary
and rerun the reports.

7. Print or create a PDF and file the following reports as of your closing date: General
Ledger, Balance Sheet Standard, Statement of Cash Flows, Trial Balance, Inventory Valuation |
Surnmary, and Profit & Loss Standard for the year. |

8. Back up your data file on a special backup drive or network server, or CD. The year-
end backup should be permanent and stored in a safe place.

9. Set the closing date to the last day of the period and set a closing date password to
prevent transactions in the closed period from being changed. See page 435 for details
on setting the closing date. ;

10.  Consider using the Clean up Data File utility. This will “condense” (reduce) the size of -
your data file, but will probably not be necessary every year. Data file cleanup is an '
involved process that should be done by your accountant or QuickBooks consultant.

Recording Closing Entries for Sole Proprietorships and Partnerships |

Note:

Do not enter the transactions in this section. However, do familiarize yourself
with these issues so that you can properly close the year in a sole proprietorship
or partnership company.

Sole proprietorships have the following accounts in the Equity section of the Chart of Accounts
(see Figure 13-16).
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432 Adjustments and Year-End Procedures — Closing the Year

"\ Chart'of Accounts'

Shlame
+ 30000 * Opening Bal Equity 0.00 a5
+ 30800 - Owner Draw 0.00

l 432000 * Owners Equity 0.00 i
OO0 SeTTiCeT— k
445000 - Sales | |
+46000 * Sales Discounts
250000 - Cost of Goods Sold Sole Proprietorshlp
453000 * Purchase Discounts Equity Accounts r

Figure 13-16 Sample Equity Section - Sole Proprietorships

Partnerships have the following accounts {or similar accounts) in the Equity section of the
Chart of Accounts (see Figure 13-17). Although this list of accounts has a Retained Earnings
account, it will be cleared out at the end of each year to keep it from accumulating a balance.

)

+ 30000 - Opening Bal Equity Equity 0.00 3
+ 30300 - Partner 1Draws Equity 0.04
+ 30400 - Pariner 1Equity Equity 0.00 i
%+ 30500 * Partner 2 Draws Equity 0.00 E]
l 430600 * Partner 2 Equity Equity 0.00 s
TRty 1,
+40000 - Services fmeome -
245000 - Sales Income 4| | Partner Equlty
+ 46000 - Sales Discounts Income ~ i1 || Accounts
| “acconnt v]| Acivites [ Regorts ][ Attach | [incude inactive -
o Ly

Figure 13-17 Sample Eq:)fty section - Partnerships

Throughout the year, as owners put money into and take money out of the business, you will
add transactions that increase and decrease the appropriate equity accounts. In a sole
proprietorship, you will use the Owner’s Equity and Owner's Draw accounts. In a partnership,
you will use the Equity and Draws accounts for each partner.

To record owners' investments in the company, enter a deposit transaction in your Checking
account (or the account to which you make deposits), and enter Owners Equity in the From
Account field (see Figure 13-18).

f ERETN : G — —
& Previous [P Net [ Save o Print v|paymem £ History | [ Attach . - ST §
'
DepositTo | 10100+ Ch... v| Date ;03/0/2015[M] Mema |Deposit _ ] K
‘1
Click Payments to select customer payments that you have received. List any other amounts to deposit below. :
;
Received From  From Account Memo ChkMo.  PmtMeth, Class  Amount | k
32000 - Owners Equity  |Cash from Owner 5416 Check 5,000.00 + Y
3
3;

f

Figure 13-18 Record owner’s investments in the Make Deposits window
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To record ownet'’s withdrawals from the company, enter a check transaction in the Checking
account {or the account from which the owner draws money), and enter Owners Draw i1 the
Account field (see Figure 13-19).

i A b L S e b e B0 e s cha
] %2 Previois O Nest - RSove: - Pt v | T Find | @ sesch

ks
‘| BankAccount [10100 - Cheding -] EndngBalance  11,562.00

No, 330

Date 02/28/2015 [R] B
Pay to the Order of Ve Black Pt $ 1,000.00 .

TR

One thousand Nwtmttt..t-‘t.tt!t-!.l.tttt.tttttt-tttt-MNE :
Yern Black :

. §0.00 Orniine Payment [} To be printed

Figure 13-19 Record owner’s withdrawals as a check transaction

Closing Sole Proprietorship Draw Accounts

At the end of each year, you will create a General Journal Enfry to zero out the Owner's Draw
account and close it into Owner’s Equity (see Figure 13-20).

Rt

) previous [ Nea -3 suve 6Pﬁnt.. | % rﬁsto- R Reverse || @ Astach

e e

; o L i
Rate [12/31/2015 ] EntryNo. |2015-3 | [
i
1 Account . Debit Credit Memo Name Bdable? Class I
#1 | 10900 - Joumal Entries To Close Ovwner's Draw »
i» 32000 * Owners Equity 1,000.00 To Close Owner's Draw IE E
f; 30800 * Owner Draw 1,000.00 [To Close Owner's Draw ;,
| i
A
kG

Figure 13-20 General journal Entry to close Owners Drow

To find the amounts for this Journal Entry, create a Trial Balance Report for the end of the
year. Use the balance in the Owner’s Draw account for a General Journal Entry to close the
account. For example, if your Trial Balance shows a debit balance of $1,000.00 in Owner's
Draw, enter $1,000.00 in the credit column on the Owner’s Draw line of this General Journal
Entry. Then enter a debit to the Owner’s Equity account to make the entry balance.

Closing Partnership Draws Accounts

To close the Partners’ Draws accounts into each Partner’s Equity account, use a General Journal
Entry like the one shown in Figure 13-21. Use the same process explained above to get the
numbers from the year-end Trial Balance.
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IS PR . ST
" [T Malke Genesal Journal Entries ; R : R
@ Previous BPNot [ Sove G Print.. | By History [ Reverse || § Attach

Date '12/31/2015[M8} EntryNe. [2015-7

Memo

To Close Partner's Draw
To Close Partner’s Draw
1,000.00 | Ta Close Pariner’s Draw

Credit

Debit

Account

10300 * Journal Entries
30400 - Partner 1 Equity
30300 - Pariner 1Draws

1,000.00

Figure 13-21 General journal Entry to close partner’s draws accounts

Distributing Net Income to Partners

With partnerships, you need to use a General Journal Entry to distribute the profits of the
company into each of the partner’s profit accounts. After making all adjusting entries, create a
Profit & Loss Report for the year. Use the Nef Income figure at the bottom of the Profit & Loss
Report to create the General Journal Entry, in Figure 13-22. In this example, assume net income
for the year is $50,000 and that there are two equal partners in the business.

e o 2

E Mai:e Ge;erai Jeumal Er?i:‘ns
<« previous [ Next [ Sove 3§ Print... | 03 History [# Reverse il § Attach

Date |01/012016 [H] EntryNo. 20154

Debit Credit Name Biflable? Class

Account

10500 * Journal Entries
32000 * Retained Earnings
30400 - Partner 1 Equity
* Partner 2 Equity

50,000.00

25,000.00 5056 Alocation to Partner 1
25,000.00 |50% Allocation bo Partner 2

Figure 13-22 Use a General fournal entry to distribute partners’ profits

Note that the General Journal Entry in Figure 13-22 debits Retained Earnings. That is because
QuickBooks automatically closes net income into Retained Earnings each year. This is the
entry you'll make each year to zero out the balance in Retained Earnings and distribute the net
income to the partners.

Also, note that the General Journal Entry is dated January 1. This is because there is no “after-
closing” Balance Sheet in QuickBooks. The December 31 Balance Sheet should show
“undistributed” net income for the year. If the General Journal Entry were made on December
31, you would never be able to see a proper (before closing) December 31 Balance Sheet.
Therefore, to preserve the December 31 before-closing Balance Sheet, use January 1 for this
closing entry. If you want to see an after-closing Balance Sheet, use January 1 for that Balance
Sheet.

Tip:

To preserve the after-closing date Balance Sheet, it is best to change the date on
all normal business transactions that occur on January 1 to January 2, Use
January 1 exclusively for the previous year’s “closing” entries.
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Setting the Closing Date to “Lock” Transactions

QuickBooks allows the administrator to set a closing date that effectively locks the file so that
no one can make changes to transactions dated on or before a specified date.

Note:

Several privileges are reserved for the administrator of the file. For example, the
administrator is the only one who can view or change the company information
(name, address, etc.) for the file. Also, the administrator is the only one who can
make any changes to the Company Preferences tabs in the Preferences section. For
more information about the file administrator, see the QuickBooks onscreen

Help.
COMPUTER PRACTICE
To set or modify the closing date and closing date password, follow these steps:
Step 1. Select Preferences from the Edit menu and then select the Company Preferences
tab for the Accounting preference.
Step 2. Click the Set Date/Password button at the bottom of the window (see Figure
13-23).
B compen et
_‘ giis G Accounts. Cancel
) Calendar [#] Use account pumbers 7] Require accounts
|l cheding ] Show lowest subaccount only
| | BHA Desktop view -_Qefgn
|| %y Fnance Charge (] Use dags tracking
; % Cenerd Tl Prompt to assign dasses Also See:
‘| §H Integrated Applicatio ¥] Automatically assign general journal entry number Geperal
i ‘ Items & Inventory Warn when posting a ransaction to Retaned Eamings
‘|14 Jobs &Estmates - Date Warrings ' mvg
T Multiple Currencies Wan if transactions are 190 | dav{s) in the past
| Payments [ Warn if transactions are 30 | dav(s) in the future
(B payrol 8 Employees . e
% Reminders Closing Date
W3 Reports 8 Graphs Date through which books are dosad: {not set)
FpeaT—
| g Sales Tax
&), Sexch
Send Forms
&% service Connection
| [ seeling -
Figure 13-23 The Set/Date Password button in the Accounting Company Preferences
Step 3. The Set Closing Date and Password window opens (see Figure 13-24). Enter

12/31/2015 in the Closing Date field.

The date you enter specifies that all transactions dated on or before that date are
“locked.” Depending on each user’s access privileges, QuickBooks either prohibits
additions, changes, or deletions to any transactions with a date on or before this
date; or, warns users before they make additions, changes, or deletions. To further
protect transactions in closed periods you can also require all users, including the
administrator, to enter a password before they can add, change, or delete
transactions dated on or before the closing date.

Adjustments and Year-End Procedures - Setting the Closing Date to “Lock” Transactions




436 Adjustments and Year-End Procedures — Review Questions

Tip:

The user's setup affects the ability to add, change, or delete locked (“closed”)
transactions. When setting up new users, always choose the setting that prevents
them from making additions, changes, or deletions to transactions recorded on
or before the closing date. Unless the Closing Date Password is set, the
administrator of the file can always bypass the closing date by simply ignoring a
warning window. To better protect the closing date in your QuickBooks file,
require all users, including the administrator, to enter a Closing Date Password.

Step 4. Enter Abcd?234 in the Closing Date Password and Confirm Password fields and click
Cancel (see Figure 13-24). For this exercise, you won't save the changes. In reality,
you will want to use a strong password.

To keep vour finandal data secure, QuickBooks recommends assigning al other users their own
username and password, in Company > Set Up Users,
Date

QuickBooks will display a warning, of require a password, when saving a transaction dated on
or before the dosing date, More details...

] Exdude estimates, sales orders and purchase orders from dosing date restrictions

Cosing Date [ 12/31/2015 (8]

Password
Quickbooks strongly recommends setting a password to protect transactions dated on or
before the dosing date.
Closing Date Password [s0seeeee |
Confirm Password [o _ [

To see changes made on or before the dosing date, view the Closing Date Exception Reportin
Reports > Accountant & Taxes.

T

Figure 13-24 Set Closing Date and Password window

Step 5. Click OK on the Preferences window.,

QuickBooks will now require all users to enter this password when attempting to
add, change, or delete transactions dated on or before the Closing Date.

Note:

Your accountant will probably recommend that you set the Closing Date at the
end of each year (if not more frequently) to prevent users from accidentally
changing transactions after your company has filed its tax return.

Review Questions

Select the best answer for each of the following:

1. Which of the following tasks does QuickBooks perform automatically at year-end?

a)  Creates adjusting journal entries to the income and expense accounts that can
be viewed in the General Ledger report

b)  Identifies expenses that are too high in comparison with prior years

¢)  Adjusts the balance in the Retainied Earnings account to reflect the net income or
loss for the year

d)  Automatically backs up the data file
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2. Entering a date in the Closing Date field accomplishes which of the following:

a}  Determines which date QuickBooks will use to automatically close the year

b)  Determines which date QuickBooks closes your file

<) Locks the data file so that no unauthorized users can add, change, or delete
transactions dated on or before the Closing Date

d)  Prepares a closing entry on that date

3. Voiding and Deleting transactions both do the following:

a) Keep a record of the date, number, and detail of the transaction
b}  Completely remove all details of the transaction

¢)  Zeroout the debits and credits specified by the transaction

d) Bothbandc

4. To make an adjustment to Items as well as their associated accounts, create a:

a)  General fournal Entry

b}  Fixed Asset

c) Zero-Dollar Check

d) Memorized Transaction

5. At the end of the year, you should perform the following:

a)  Enter depreciation entries

b)  Perform a physical inventory

c)  If your business is a partnership, enter a General Journal Entry to distribute net
income for the year to each of the partner’s capital accounts. If your business is a
sole proprietorship, enter a General Journal Entry closing Owner’s Draw and
Owner’s Investments into Owner’s Equity

d}  All of the above

Adjustments Problem 1

APPLYING YOUR KNOWLEDGE

| Restore the Adjustments-11Problem1.QBM file.

1. Create General Journal Entry #2015-1 on 01/31/20135 to recategorize $167.00 from Office
Supplies Expense to Postage and Delivery Expense (Hint: Debit Postage and Delivery,
credit Office Supplies). Use the Journal Entries account on the top line of the General
Journal Entry as discussed in the chapter. Enter a descriptive memo Recategorize Postage
on the top line of the entry. Class: San Jose.

2. Create a General Journal Entry on 01/31/2015, #2015-2, recording $85.00 in Depreciation
for Fixed Assets (Hint: Debit Depreciation Expense, credit Accumulated Depreciation).
Use the Journal Entries account on the top line of the General Journal Entry and enter a
descriptive memo Depreciation for Fixed Assets on the top line of the entry. Class: San
Jose.

3. Memorize the depreciation Journal Entry from the previous step using the
Edit/Memorize General Journal option and schedule it to be automatically entered
every month from February through December (11 remaining entries). Name the
transaction “Monthly Depreciation.” If you see the Start up message regarding
automatically entering the memorized transactions, select Later and do nof enter the
transactions.
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4. Create and print a Balance Sheet (Standard) as of 01/31/2015.

5. Create and print a Journal Report for 01/01/2015 through 01/31/2015 (The Journal
Report is in the Accountant & Taxes section of the Reports menu.) Filter the repozrt to only
show Journal transactions.

Adjustments and Year-End Procedures — Review Questions




